CONCURRENT ENGINEERING

1. CONCEPTUAL DESIGN
2. SOLIDS AND SURFACE MODELING
3. DESIGN ANALYSIS
4. MANUFACTURING SIMULATION
5. ASSEMBLY MODELING AND CHECKING
6. RAPID PROTOTYPING
7. DRAFTING AND DOCUMENTATION
8. PRODUCTION
9. MARKETING
10. MAINTENANCE
11. DISPOSAL

3-D GEOMETRIC DATA BASE
ADVANCED 2-D SKETCHING

In the first Computer Graphics Lab 1, you used some of the basic 2-D sketching capabilities of SolidWorks. These first exercises concentrated on using items that were available on the sketching toolbars. You learned how to draw a Line, Circle, Rectangle, Arc, Polygon, Centerline, and Spline. You also learned how to edit the 2-D sketch using Dimensions, Trim, Mirror, Fillet, and Chamfer functions. In this Computer Graphics Lab 2, you will learn some more advanced 2-D sketching and editing features that are available in the vast SolidWorks menu structure.

SKETCH ENTITY MENU

The sketch entities on the right side toolbar are not the only ones available. From the Tools pull-down menu, you can find all of them under the Sketch Entities selection menu as Shown in Figure 2-1. Here you can find the following 2-D sketch entities:

- Line
- Rectangles (several options)
- Parallelogram
- Slots
- Polygon
- Circle
- Perimeter Circle
- Centerpoint Arc
- Tangent Arc
- 3 Point Arc
- Ellipse
- Partial Ellipse
- Parabola
- Spline
- Spline on Surface
- Point
- Centerline
- Text

Some of these 2-D entities are more common in engineering design than others, but hopefully you will have a chance to use each of them somewhere in one of your exercises.
SKETCH TOOLS MENU

All of the 2-D sketch editing functions are found under the Sketch Tab. On this menu you will find the following common editing functions:

**Fillet** is used to round a corner with a radius.
**Chamfer** is used to cut a corner at an angle.
**Offset Entities** is used to create another exact copy at a linear distance away.
**Convert Entities** converts an entity from an earlier feature to the current sketch.
**Trim** cuts away a piece of the entity.
**Extend** extends an entity to meet another entity.
**Mirror** copies a pattern around a centerline.
**Dynamic Mirror** first select the entity about which to mirror and then sketch the entities to mirror.
**Jog Line** moves a piece of the line up or down in a rectangular shape.
**Construction Geometry** converts entities to construction geometry or the converse.
**Linear Sketch Pattern** creates a rectangular array (row X column) of identical entities (see Figure 2-3).
**Circular Sketch Pattern** creates a radial (or polar) array of identical entities around a center point (see Figure 2-4).
**Align** is used to align a sketch and a grid point.

![Figure 2-2. The Sketch Tools Menu.](image)

![Figure 2-3. Linear Sketch Pattern.](image)

![Figure 2-4. Circular Sketch Pattern.](image)
Exercise 2.1: METAL GRATE

In Exercise 2.1, you will design a Metal Grate. The function of a metal grate is such that many identical slots are cut through it. Instead of drawing each slot separately, you will use an advanced sketching feature of SolidWorks and create a rectangular array of these slots. Then you can simply extrude a base to create the beginning grate feature.

Start by going to your folder and Open the file ANSI-METRIC.prt dot because the dimensions of the Metal Grate are in Metric units. Immediately SAVE AS – METAL GRATE.sldprt. You will not need a grid for this exercise. Go to Tools – Options - Document Properties and click the Grid/Snap tab and make sure the “Display Grid” function is not checked (✓) on, then click the OK button. Click the Front plane in the Feature Manager for the sketch plane.

Now activate the Sketch Tab and click the Sketch (pencil) icon to start your sketch. You will first draw two Rectangles. The first one is the large outline of the grate and the second one is the initial small rectangular slot that eventually will be arrayed. Refer to Figure 2-5 below for applying each Dimension. The overall size of the grate is 280 mm by 195 mm, and it is centered about the origin with its other two dimensions (140 and 97.5). The small slot is 20 mm by 35 mm, and is 30 mm below the top and 30 mm to the right of the upper left corner. Note: After all the dimensions are applied, the lines turn black. This means that the geometry is completely fixed and constrained. Using the fillet command, add 3mm fillets to the four corners of the small rectangle.

Figure 2-5. The Beginning Dimensions for the Metal Grate Centered at the Origin.
Now select the **Linear Sketch Pattern** icon in the sketch entities toolbar or pull down **Tools**, select **Sketch Tools** and then pick the **Linear Pattern** option. The “Linear Pattern Repeat” menu pops onto the screen. The Entities to Pattern box at the bottom of the menu is prompting you to select the lines and fillets of the small rectangle. The settings for this rectangular array operation are shown in **Figure 2-6** below. “Direction 1” is horizontal and will have 6 repeats. The horizontal spacing is 40 mm and the angle is 0 degrees. To activate “Direction 2” change the number of repeats to 3. You will then be able to change the vertical spacing to 50 mm and the angle to 270 degrees. Notice that as you make adjustments to the linear table a **Preview** of the operation is shown before it is officially executed. If it is correct, click the **OK** button to complete the array. You should have a 6 x 3 array of slots that now can be extruded. You will have to click on the arrows to the left of the Y-axis button under Direction 2 to make the boxes drop below and onto the metal grate. Your pattern preview should look like the image in **Figure 2-7**.

![Figure 2-6. The Linear Sketch Step and Repeat Menu for Creating an Array of Slots.](image)

![Figure 2-7. Linear Sketch Pattern Preview](image)

Select the **Features Tab** and select **Extruded Boss/Base**

Key in the following parameters:

- Type of Extrusion = **Blind**
- Distance 1 = 5 mm

Then click the green (✔) check to close the menu. You will now have the base solid model of the grate, as shown in **Figure 2-8** in a **Trimetric** view.

The next step for the Metal Grate is to add a lip to the metal grate in order to provide a support when attached to the wall air duct. Click on this front surface of the Metal Grate. It should highlight blue. Then click on the **Sketch** tab and select the **Sketch Command** to add another sketch to the design. You have already drawn the outer rectangular profile. So you will borrow
from it for the outer edge of the lip. Click the **Convert** sketch edit icon (it looks like a cube with a blue vertical edge). The outer lines now become part of your active sketch. Notice that they are all black lines since the geometry is already fixed.

Now click the top converted line (it turns *cyan*) and then click the **Offset Entities** icon (it looks like two bent parallel lines). Key in the offset value of **15 mm** and make sure the **Select Chain** box is checked (✓). If the 15 mm offset is previewed on the outside, check (✓) the “**Reverse**” box in the menu box, so the offset is to the **inside** of the original lines and then click the green (✓) checkmark to create the offset, as shown in **Figure 2-9**. Also, notice that the offset command places a small 15 mm dimension on your sketch to indicate the offset value. You could now simply click on that dimension directly, key in a new dimension value, and instantly change the offset to a new value. But for now leave it at 15 mm. Fillet the inside corners of the offset pattern to **5mm** as shown in **Figure 2-10**.

Before you perform the Extrude command you may want to go to an Isometric view in order to see which direction you are extruding. Select the **Features** icon and select **Extrude**. When the **Extrude** menu appears, key in the following parameters:

- **Type of Extrusion** = **Blind**
- **Distance 1** = **5 mm**

Click the green (✓) check to complete the boss.

---

**Figure 2-8.** The Base Part of the Metal Grate.

**Figure 2-9** Offset Entities

**Figure 2-10.** Converting the Front Edges, Offsetting them by 15 mm and Filleting the Inside Corners by 5mm.
Now you need to add four attachment holes to the corners of the grate. **Select** the raised rim (it will turn blue). Click on the **Sketch Tab** and activate the **Sketch icon** and draw a **Circle** in the upper left corner. Use the **Dimension values** supplied in **Figure 2-11** for the circle diameter (8 mm) and position from the corner (9mm x 9mm).

Now draw three more **Circles** in the other three corners. **Dimension** them to have the same diameter (8) and same relative position (9 x 9) from each corner. Or, now that you are an expert with a rectangular array, use the **Linear Sketch Pattern** operation instead. If you use this function, then the horizontal distance of the 2 items is 262 mm and the angle is 0 degrees. The vertical distance of the 2 items is 177 mm and the angle is 270 degrees. **Either way**, when you are finished you should have circles at the four corners.

Change your viewpoint to a Trimetric view. Now activate the **Features** icon and select **Extruded Cut**. Select the extrude type to be **Through all** and click the green (√) check to execute the cut. The four corner attachment holes are now created on the grate.

The part is now complete and you can view the lip feature more clearly by using the **Rotate View** icon as shown in **Figure 2-12**.

If you would like to change the color of your model, click on the model name in the Feature manager tree and then select the colored ball in the menu bar. You can then assign any color you wish to the model.

Return to a Trimetric View of your part as shown in **Figure 2-12**. You should now save your model. Pull
down File, select Save As, type in the part name METAL GRATE.sldprt, and then click Save. Open your copy of TITLE BLOCK – METRIC.drwdot and immediately SAVE AS – METAL GRATE.slddrw. Now insert the rendered Metal Grate image into your Title Block drawing sheet that was created in Chapter 1 and Print it on this sheet (see Figure 2-13).

Print a hard copy to submit to your lab instructor.

Figure 2-13. The Metal Grate Rendered Image on a Title Block Drawing Sheet.
In Exercise 2.2 you will design a Torque Sensor casing. Since it is a circularly symmetrical object, you will employ some of the advanced editing features like circular array. Go to your folder and Open the file ANSI-INCHES.prt, and immediately SAVE AS – TORQUE SENSOR.sldprt. Select the Tools, Options, Document Properties menus and Select “Grid/Snap.” Make the following settings on this menu: “Major grid spacing” = 1.00, “Minor lines per major” = 4. Also go to System Snaps and make sure “Display Grid” and the “Snap” functions are checked (✓) on, then click the OK button. Make sure the Units are in Inches. Then click OK.

The circular features of the Torque Sensor are on the top and bottom surfaces. But the main body is also round and can be created by a 360 degrees revolution of a profile that has been drawn on a frontal plane. So click on the Front plane in the Feature Manager tree. Click on the Sketch Tab and select the Sketch Icon and the sketching grid appears with minor grids spaced every 0.25 inches. Also make sure you are viewing this from the Front view orientation.

First draw a Centerline vertically through the origin. Next use the Line tool to sketch the completely enclosed profile that is depicted in Figure 2-14. This design will yield a part that is 2.50 inches tall and 4.00 inches in diameter on the top and bottom surfaces.

Go to the Features tab and Select the Revolved Boss/Base icon. Make sure that the centerline is selected for the Axis of Revolution. Key in the full revolution value of 360° and click the green (✓) check to perform the revolution. The circular base part appears as shown in Figure 2-15 in an Isometric view.

The next design step is to create a circular array of eight holes around a bolt circle on the top surface of the part.

Figure 2-14. The Initial Lines to Revolve for the Base Part.

Figure 2-15. The Base Part after the Revolution.
Click on the top surface of the part and it should highlight blue. Also select a Top view orientation. Then select the Sketch icon. Draw a Circle that is 3.25 inches in diameter, make sure you select “for construction” in the feature manager tree. Then draw a horizontal center line from the origin and to the right. The intersection of these two entities defines the center of the first of eight holes thus resulting in a radius of 1.625. Or you can go to the Document Properties menu and on the Grid/Snap tab change the “Minor lines per major” value to 8, thus resulting in a one-eighth inch grid. Also on the Units tab change the decimal places to 3. Click OK and the grid should now be updated to the new values. Now locate the center of the first Circle on the grid and draw it with a diameter of 0.25. Use Figure 2-16 to aid you.

Select the circle (it should highlight blue). Click on the down arrow next to Linear Sketch Pattern to select the Circular Sketch Pattern option. The “Circular Pattern” menu appears on the screen. Referring to Figure 2-17, set the parameters for this circular array. The “Radius” is 1.625 from the center (0,0). The “Step Number” is 8 for a “Total angle” of 360°. The spacing is “Equal” checked (✓) on. Click Preview to see if everything is correct, and then click the OK button. You now have a bolt circle of 8 holes as previewed earlier in Figure 2-16. You are now ready to cut these holes through the entire base part.

Figure 2-16. Sketching the First Circle and Executing a Circular Array of Eight Holes.

Figure 2-17. The “Circular Pattern” Menu to Create the Bolt Circle Holes.
Switch to the **Shaded** model mode and to an **Isometric** view to better see the next operation. Select the **Features** tab and select ** Extruded Cut**. On the “Cut Extrude” menu select **Through all** for the direction and click the green (√) check to execute the cut extrusion all the way through the model. Use the **Rotate View** icon to see that the holes are indeed all the way through the bottom of the model. If so, then the model is complete as shown in Figure 2-18.

If you would like to change the color of your model, click on the model name in the Feature manager tree and then select the colored ball in the menu bar. You can then assign any color you wish to the model.

You should now save your model. Pull down **File**, select **Save As**, type in the part name **TORQUE-SENSOR.sldprt**, and then click **Save**. Open your **TITLE BLOCK – INCHES**.drwdot and **SAVE AS:** **TORQUE SENSOR.slddrw**. Now insert the rendered Torque Sensor image into your **Title Block** drawing sheet that was created in Chapter 1 and **Print** it on this sheet (see Figure 2-19).
Exercise 2.3: SCALLOPED KNOB

In Exercise 2.3, you will design a Scalloped Knob that has some complicated geometry around its edges. This particular knob design will be a hexagon type. Since the hexagonal features are equally spaced around the center of the knob, you can use a circular array function.

Start by going to your folder and Open the file ANSI-INCHES.prtdot and immediately SAVE AS – SCALLOPED KNOB.sldprt. Select the Front plane for the sketch. Then start a new Sketch. Complete the initial geometry of the sketch according to Figure 2-20. Using the Line tool, draw two vertical lines and cap them off with a horizontal line that touches their top ends. Fillet the top two corners with a 0.10 radius. Use the Dimension tool to completely fix the geometry by applying the dimensions shown in Figure 2-20. Include dimensions that relate to the origin. When the geometry is fixed, all lines turn black.

Now array this pattern in a circle to form a hexagonal layout. There is a pull-down arrow next to the Linear Sketch Pattern. When you select it you will see the Circular Sketch Pattern option. The “Circular Pattern” menu appears on the screen. Set the “Step Number” to 6 for a “Total angle” of 360°. The spacing is “Equal” checked (✓) on. Activate the “Entities to Pattern” box and select the three straight lines and the two fillets. Click Preview to see if everything is correct, and then click OK. You now have an array that is the beginning of the sketch for the knob outline. Notice that some of the lines may overlap as can be seen in Figure 2-21. You may want to trim the intersecting lines; however that is not necessary to complete the remainder of the exercise.
Next you will fillet the six sharp inner corners to create the scallop effect. Pick the Fillet sketch icon and key in a fillet radius of 0.45 in the “Sketch Fillet” parameter box. Now pick two intersecting lines. A large 0.45 radius is made and a small dimension is attached to show the fillet value. Repeat this filleting process on the remaining five sharp inner corners. When you are finished, your sketch should look like Figure 2-22.

Select the Features tab and select Extruded Boss/Base. Extrude the sketch to a Blind depth of 0.375 inches. Click the green check (✓) to close the operation. When finished, view the part in a Trimetric orientation as shown in Figure 2-23.

You now can finish the part by adding the attachment base. Click the front surface to highlight it in blue. Set your view orientation to Front. Click the Sketch icon and draw a Circle, centered at the origin. Dimension the circle to be 1.00 inch in diameter. Now draw a Hexagon at the origin. Check Inscribed Circle and set the radius to 0.50 inches in diameter. Select the Features icon and select Extrude. It is advisable to go to an Isometric view when executing an extrusion of any kind. Extrude the sketch to a Blind depth of .75 inches away from the front surface.

Select the Rotate View icon to better see the extruded attachment base and the hole for the scalloped Knob, as shown in Figure 2-24. Then return to an Isometric view, and click the Shadows in Shaded icon to see the finished part as shown in Figure 2-25.

If you would like to change the color of your model, click on the model name in the Feature manager tree and then select the colored ball in the menu bar. You can then assign any color you wish to the model.

Now save your model to your designated folder. Pull down File, select Save As, type in the part name SCALLOPED KNOB.sldprt, and then click Save. Open your TITLE BLOCK – INCHES.drwdot and immediately SAVE AS – SCALLOPED KNOB.slddrw. Now insert
the rendered Scalloped Knob image onto your **Title Block** drawing sheet that was created in Chapter 1 and **Print** it on this sheet (see **Figure 2-26**).

**Print** a hard copy to submit to your lab instructor.

**Figure 2-24.** A Rotated View of the Finished Knob.

**Figure 2-25.** The Shaded Model of the Scalloped Knob with a Shadow.

**Figure 2-26.** The Scalloped Knob Rendered Image on a Title Block Drawing Sheet.
Exercise 2.4: LINEAR STEP PLATE

In Exercise 2.4, you will design a Linear Step Plate used for linear motion control in machinery. There are a lot of holes on this plate, and you will find the linear array and mirror functions to be quite helpful. Start by going to your folder and Open the file ANSI-INCHES.prtdot, immediately SAVE AS – LINEAR STEP PLATE.sldprt. Select the Right Plane as the drawing plane and the Right view orientation to see it head on. Then start a new Sketch. Draw a vertical centerline through the origin. Go to TOOLS – Sketch Tools, Select Dynamic Mirror. Now sketch the right half of the profile shown in Figure 2-27. Each line drawn on the right side of the centerline will be duplicated on the left. Use the Dimension tool to set the geometry by applying the dimensions shown in the Figure 2-27, including the dimension to the origin.

Select the Features icon and select Extruded Boss/Base. On the “Base Extrude” menu, set the extrude parameters as shown in Figure 2-28:

Direction 1: Blind, 2.1000 in.
Direction 2: Blind, 2.1000 in.

OR

Extrude the sketch 4.2 in. MID-PLANE

Notice that you can preview this operation in an Isometric view on the screen. Then click the green (√) check to close the menu and execute the extrusion in two directions. The base part looks like Figure 2-29.
Now you will create some linear holes. **Pick the top surface of the small step on the front side** (see Figure 2-29). It should highlight blue. In a Top view, click Sketch and draw a small Circle on the surface as shown in Figure 2-30. Use the Dimension tool to add the three dimensions given to fix it:

Diameter = 0.1500  
From center origin = 0.5625  
From center origin = 1.5000

Now you will linearly repeat that circle. **Select** the circle (it should turn cyan). Select the Linear Sketch Pattern icon, at the top of the screen. The “Linear Sketch Step and Repeat” menu pops onto the screen. Key in the following parameters:

**Direction 1:**
- Number = 6  
- Spacing = 0.6000  
- Angle = repeat to right side

**Direction 2:**
- Number = 1

You now should have six circles on the front step surface. You need to add six more circles to the back step surface. You can mirror them.

Draw a horizontal Centerline across the origin (Note the “—” symbol on your cursor means horizontal). Click the Mirror sketch icon and the mirror menu pops onto the screen. For the “Entities to Mirror,” select the six circles just created in the Linear pattern and in the “Mirror About” box select the centerline drawn through the origin. The selected items will get mirrored about the centerline, as shown in Figure 2-31.
Select the **Features** icon and select **Extruded Cut**. Use the **Through All** option and click the green (✓) check to close the menu. You have now drilled the small holes all the way through the plate’s steps. You now need to bore some counter holes a quarter of the way down the small through holes. **Note:** This design feature is called a “Counterbore” and SolidWorks has a special “Wizard” that can create it. However, we will leave that “Wizard” for a later lab.

Select the top surface of the front step again. Sketch a **Circle** on that surface. Then add a relation to make the circle concentric with the hole beneath it (The diameter is 0.25). Now repeat the exact same process as before to get the twelve circles for the counterbore holes.

- **Select** the new circle
- **Execute a Linear Pattern** to get the front 6 circles at 0.60 inches apart in **Direction 1**.
- **In Direction 2** increase instances to 2 at a distance of 1.125 inches.

Select the **Features** icon and select **Extruded Cut**. Use the **Blind** option to a depth of 0.0625 inches into the material. Click the green (✓) check to close the menu. You now bored the counterbores into the plate’s two steps, as shown in **Figure 2-33** in a Rotated View.

**Note:** Sometimes you might make a mistake with a **FEATURE** operation like this one. You can simply right mouse click on its name in the Feature Manager and select the **Edit Feature** option on the menu. See **Figure 2-34**.
The final design requirement is to create four holes on the top of the plate. Pick a Top view and select the top surface to Sketch on. Draw a first Circle with the three Dimension values given in Figure 2-35. Use a Linear Pattern operation to get a second circle 0.6000 inches from the first circle. Draw a vertical Centerline through the origin (a | appears on the cursor). Then Mirror the two circles. This results in four circles as shown in Figure 2-35.

It is advisable to go to an Isometric view when executing an extrusion of any kind. Select the Features icon and select Extruded Cut. Use the Through All option and click the green (√) check to close the menu. You now drilled the small holes all the way through the thick part of the plate. Select the top surface again to begin a new sketch. You will now add two counterbore slots. Select the Slot icon in the sketch menu. Select the straight slot type. Select the center of the left circle on the top plane and the one immediately to its right. This will make the slot concentric with the two circles to the left of the center. You can use an identical process to sketch the slot to the right of the center. Dimension the arcs of both slots to have a Radius of .20. Then Cut Extrude them to a Blind depth of 0.1250. These counterbore slots are shown in Figure 2-37.

If you would like to change the color of your model, click on the model name in the Feature manager tree and then select the colored ball in the menu bar. You can then assign any color you wish to the model.
The part is now finished. Return to an **Isometric** view of the finished part as shown in **Figure 2-37**. Pull down **File**, select **Save As**, type in the part name **LINEAR STEP PLATE.sldprt**, and then click **Save**. Open your **TITLE BLOCK – INCHES.drwdot** and immediately **SAVE AS – LINEAR STEP PLATE.slddrw**. Now insert the rendered Linear Step Plate image onto your **Title Block** drawing sheet that was created in Chapter 1 and **Print** it on this sheet (see **Figure 2-38**).

**Figure 2-38.** Linear Step Plate on the Title Sheet
SUPPLEMENTARY EXERCISE 2-5: FLANGE

Using the **Revolve** command in the **Front Plane**, the **Circular Step and Repeat** commands learned in Unit 2, in the **Top Plane** Build the Flange and extrude it according to the grid divisions. Insert it on a Title Block and title it “**FLANGE.**”

**ASSUME THE GRID DIVISIONS TO BE 0.50 INCHES.**
SUPPLEMENTARY EXERCISE 2-6:
STEEL VISE BASE

Make a full size model of the figure below using the commands learned in Unit 2. Insert it onto a Title Block and title it STEEL VICE BASE.

ASSUME THE GRID DIVISIONS TO BE 0.25 INCHES.